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Introduction
MPLAB® Harmony v3 is a software development framework consisting of compatible and interoperable
modules that include peripheral libraries (PLIBs), drivers, system services, middleware, and third-party libraries.
The MPLAB Code Configurator (MCC) is a GUI-based tool that provides an easy way to enable and configure
various MPLAB Harmony modules. The MCC is a plug-in to the MPLAB X Integrated Development Environment
(IDE).

This document explains how to create a simple application on an Arm® Cortex®-based 32-bit Microcontroller
(MCU) using the MCC with MPLAB Harmony v3 modules. This application sends a “Hello World!” string to a
console running on a computer. For this demonstration, the following MPLAB Harmony v3 modules are used
and configured using the MCC:

• Clock PLIB using the Clock Manager to configure the microcontroller clock.
• PORT PLIB using the Pin Manager to configure the microcontroller I/Os.
• Serial Communication (SERCOM) USART PLIB to configure USART peripheral as serial port.

 Creating a 'Hello World' Application on Arm
Microcontrollers Using MPLAB Harmony v3 with MPLAB
Code Configurator (MCC)

 TB3231
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1. Creating Hello World Application
This document describes how to create a "Hello World" application on the 32-bit Arm
microcontrollers using MPLAB Harmony v3 with the MPLAB Code Configurator (MCC) tool. It also
covers the necessary procedures that must be adhered to for this demonstration.

The following software and hardware tools are used for this demonstration:

• MPLAB X IDE v6.15
• MPLAB Code Configurator (MCC) Plug-in v5.3.7
• MPLAB XC32 v4.30
• MPLAB Harmony v3 repositories:

– csp v3.18.0
– dev_packs v3.18.0

• SAM D21 Xplained Pro Board

Note: The updated versions of the above listed tools can also be used to create the application,
however, users are not restricted to use the older versions.

Note: The flow and steps explained in this document can be reused for other 32-bit Arm
Microcontrollers. The user must take care of the differences in peripherals and pin configurations.

Step 1: To create an MPLAB Harmony v3-based project, follow these steps:

1. From the Start Menu launch MPLAB X IDE.
2. Once MPLAB X IDE is open, on the File menu, select New Project or click on the New Project

icon.
3. In the New Project window, under Steps navigation pane, select Choose Project. In the right

Choose Project properties section, under Categories, select Microchip Embedded and under
Projects select 32-bit MCC Harmony Project.

https://www.microchip.com/mplab/mplab-x-ide
https://microchipdeveloper.com/harmony3:mcc-overview
https://www.microchip.com/mplab/compilers
https://github.com/Microchip-MPLAB-Harmony/csp
https://github.com/Microchip-MPLAB-Harmony/dev_packs
https://www.microchip.com/DevelopmentTools/ProductDetails/ATSAMD21-XPRO
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Figure 1-1. Creating an MPLAB Harmony v3-Based Project - Choose Project

4. Click Next.
5. In the left navigation pane, select Framework Selections and in the right Manage Framework

properties section, enter these details:
a. Harmony Repository: Enter the path https://github.com/Microchip-MPLAB-Harmony.
b. Framework Path: Enter C:\harmony3 (i.e., the path to the folder in which the MPLAB

Harmony v3 packages are downloaded).
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Figure 1-2. Creating an MPLAB Harmony v3-Based Project - Framework Selection

Note: For this demonstration application, the following MPLAB Harmony v3 packages are
required: dev_packs and csp. The MPLAB Harmony v3 Content Manager tool simplifies the
downloading of the MPLAB Harmony v3 packages. If these packages are not downloaded,
then the user can use the MPLAB Harmony v3 Content Manager tool to download.

6. Click Next.
7. In the left navigation pane, select Project Settings, and in the Name and Location properties

section, enter these details:
– Location: Indicates the path to the root folder of the new project. All project files

will be placed in this folder. The project location can be any valid path, for example:
C:\Users\HarmonyProjects\tech_brief.

– Folder: Indicates the name of the MPLAB X IDE folder. Enter hello_world_sam_d21_xpro to
create a hello_world_sam_d21_xpro.x folder.

– Name: Enter project name as getting_started_hello_world_sam_d21_xpro. This name will be
displayed in the MPLAB X IDE.

– Path: The path information will be updated automatically as and when users make changes
to other fields.
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Figure 1-3. Creating an MPLAB Harmony v3-Based Project - Project Settings

Note: Click the Show Visual Help button to open a Contextual Help window for a detailed
description of various fields in the Project Settings.

8. Click Next.
9. In the left navigation pane, select Configuration Settings and in the Configutation Settings

properies page, enter these details:
– Name: Enter the configuration name as sam_d21_xpro.
– Target Device: Choose ATSAMD21J18A.
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Figure 1-4. Creating an MPLAB Harmony v3-Based Project - Configuration Settings

Note: Click the Show Visual Help button to open a Contextual Help window for a detailed
description of various fields in the Configuration Settings.

10. Click Finish to launch MCC.
Note: If MCC is not launched after clicking the Finish button, users can launch it by selecting
Tools > Embedded > MPLAB® Code Configurator v5 from the MPLAB X IDE.

11. In the MCC Content Manager Window, click Select MPLAB Harmony.

Figure 1-5. Configuration Database Setup
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12. Click Finish.

Figure 1-6. Finishing Database Setup

13. The MCC plugin will open in a new window. The image below highlights different sections
available in MCC.

Figure 1-7. MPLAB Harmony v3 Configurator Window

14. For additional information on MCC and how to create the MPLAB Harmony v3 project, visit:
microchipdeveloper.com/harmony3:mcc-overview.

Step 2: To add and configure the MPLAB Harmony components using MCC, follow these steps:

1. To launch Clock Easy View in MPLAB X IDE, click Project Graph. In the Plugins drop-down list,
select Clock Configuration. The Clock Easy View will be displayed within the MCC Window.

https://microchipdeveloper.com/harmony3:mcc-overview
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Figure 1-8. MCC Clock Configuration

2. In the Clock Easy View window, scroll to the right and verify the main clock is set to 48 MHz.

Figure 1-9. MPLAB Harmony v3 Clock Configurator - Clock Easy View

3. To add and configure the USART Peripheral Library, follow these steps:
a. Select Resource Management (MCC).
b. Under Device Resources, select Libraries > Harmony > Peripherals > SERCOM.
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c. Double-click on the SERCOM3 Peripheral Libray to add it to the project.

4. Select the SERCOM3 Peripheral Library in the Project Graph, and in the Configuration Options
properties section configure it as follows:

– SERCOM Operation mode is set for USART with Internal Clock (default setting).
– Clear Receive Enable, as the string will only be transmitted in this example.
– Set the Baud Rate to 115200 Hz.
– For Transmit Pinout choose SERCOM PAD[0] (default setting)
– By default, the Receive Pinout is SERCOM PAD[0]. If the Receive Pinout feature is disabled, it

will not affect the operation.
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Figure 1-10. MCC SERCOM Configuration

5. Configure the USART pin in the Pin Settings: In the MCC, select Project Graph.
6. In the Plugins item list, select Pin Configuration to open the Pin Settings window.

Figure 1-11. MCC Pin Configuration
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7. The MCC Pin Settings window will open and display these options: Pin Diagram, Pin Table, and
Pin Settings.

Figure 1-12. MCC Pin Settings Window

Note: According to the schematic of the SAM D21 Xplained Pro Board, the on-board Embedded
Debugger (EDBG) can be used as Virtual Com Port to have serial communication between the
SAM D21 device and a connected computer console. Therefore, the PA22 (Pin #43) of the SAM
D21 device must be configured as USART_TX (SERCOM3 PAD0).

8. Click Pin Settings and configure the PA22 pin as SERCOM3_PAD0.



 TB3231
Creating Hello World Application

 Technical Brief
© 2023 Microchip Technology Inc. and its subsidiaries

DS90003231C - 13

Figure 1-13. SERCOM Pin Settings

9. The PA22 pin can also be configured by clicking the Pin Table tab.

Figure 1-14. SERCOM Pin Table
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Notes: 
1. The USART_TX function (Transmit Pinout) is by default configured to be on SERCOM3 PAD0,

for additional information, refer to the MCC SERCOM Configuration.
2. In the SERCOM3 USART configuration, the USART is enabled only for transmit functionality.

Therefore, the USART receive pin is not configured.

Step 3: To generate the code, follow these steps:

1. In the Tools drop-down menu, select Options, and in the Options Window, select Plugins.
2. By default, the Autosave MCC configuration file option is selected (That means MCC

automatically saves any configurations done).

Figure 1-15. MCC Autosave

3. Click OK.
4. Click Resource Management (MCC), and then click Generate to generate the code.
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Figure 1-16. MCC Generate Code

5. The above step triggers these actions in MCC:
– Generates the code as per the configurations done.
– Place the generated code and required MPLAB Harmony framework files in

the MPLAB Harmony project directory, in this case the project directory is
C:\Users\HarmonyProjects\tech_brief .

– MCC will include all MPLAB Harmony library files and generate the code based on the MCC
selections. The generated code will add files and folders to the MPLAB Harmony v3 project
as shown in the following figure.
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Figure 1-17. MCC Generated Code

6. The generated code descriptions are as follows:
– definitions.h: Includes all header files required for the project.

– initialization.c: Initializes all the MPLAB Harmony modules used in the application.

– interrupts.c: Contains the mapping of all interrupt vectors on the selected device.

– main.c: A function call to initialize the system present in this file. The user needs to develop
their application in this file.

– peripheral: All peripheral source codes are added in this folder.

Note: MCC provides an option to change the generated file name, and if this option is not used,
by default, the file name main.c is generated.
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Figure 1-18. MCC System Configuration

Step 4: To develop and run an application, follow these steps:

1. Developing an application: For this demo application, add the highlighted codes (as shown in
image below) in the main.c file. This will send the “Hello World!” string to the console running on
the PC.
The following code is provided for convenience:

uint8_t buffer[]= "Hello World!\r\n";

SERCOM3_USART_Write(&buffer[0], sizeof(buffer));
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Figure 1-19. Developing Application

2. Selecting Hardware Tool and Compiler: In the MPLAB X IDE Project Properties window perform
these actions:
a. In the Categories section, select Conf: (sam_d21_xpro).
b. In the Configuration section, select the Connected Hardware Tool and compiler toolchain as

shown below.
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Figure 1-20. MPLAB X IDE Project Properties

3. Click OK.
4. Connecting Hardware: Connect a micro-USB cable between the Debug USB port on the board

and the PC. This enables the programming of the microcontroller and provides a serial
connection with the console device (computer).

Figure 1-21. Hardware Connection
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5. Setting up the Serial Console: Open a terminal application, such as Tera Term on the PC and
perform the Serial Port setup. Below is the default setup details for Tera Term.

Figure 1-22. Serial Port Setup

6. Programming and Running the Application: In MPLAB X IDE, click the Make and Program icon
on the SAM D21 Xplained Pro Kit.

Figure 1-23. Make and Program

7. Observing the Output: Observe the “Hello World!” string on the console and if it is not found,
press the Reset button on the SAM D21 Xplained Pro Board to reset the device, and ensure that
the USART message is communicated.

Figure 1-24. Observing Output
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2. Resources
• For additional information on MPLAB Harmony v3, refer to the Microchip web site:

https://www.microchip.com/mplab/mplab-harmony
microchipdeveloper.com/harmony3:start

• Detailed documentation on various MPLAB Harmony v3 components can be found in the
documentation folder of the corresponding repository.

• SAM D21 Xplained Pro kit details can be found here:
www.microchip.com/DevelopmentTools/ProductDetails/ATSAMD21-XPRO

• For additional informaiton on 32-bit Microcontroller Collaterals, Solutions, and Reference Guides,
refer to:
ww1.microchip.com/downloads/aemDocuments/documents/MCU32/ProductDocuments/
ReferenceManuals/32-bit-Microcontroller-Collateral-and-Solutions-Reference-Guide-
DS70005534.pdf

https://www.microchip.com/mplab/mplab-harmony
https://microchipdeveloper.com/harmony3:start
https://www.microchip.com/DevelopmentTools/ProductDetails/ATSAMD21-XPRO
https://ww1.microchip.com/downloads/aemDocuments/documents/MCU32/ProductDocuments/ReferenceManuals/32-bit-Microcontroller-Collateral-and-Solutions-Reference-Guide-DS70005534.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/MCU32/ProductDocuments/ReferenceManuals/32-bit-Microcontroller-Collateral-and-Solutions-Reference-Guide-DS70005534.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/MCU32/ProductDocuments/ReferenceManuals/32-bit-Microcontroller-Collateral-and-Solutions-Reference-Guide-DS70005534.pdf
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3. Revision History
Revision C - 11/2023
Made numerous editorial updates along with the following revisions throughout the document:
• Updated all references of the MHC to read MCC
• Updated numbered processes to describe the new MCC content
• Replaced all images in the document to reflect the update to the MCC

Revision B - 02/2020
Typographical updates.

Updated all references for MPLAB Harmony to display MPLAB Harmony v3.

Revision A - 12/2019
This is the initial released version of this document.
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Microchip Information
The Microchip Website
Microchip provides online support via our website at www.microchip.com/. This website is used to
make files and information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design
resources, user’s guides and hardware support documents, latest software releases and archived
software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests,
online discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases,
listing of seminars and events, listings of Microchip sales offices, distributors and factory
representatives

Product Change Notification Service
Microchip’s product change notification service helps keep customers current on Microchip
products. Subscribers will receive email notification whenever there are changes, updates, revisions
or errata related to a specified product family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support
Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are
also available to help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:

• Microchip products meet the specifications contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is secure when used in the intended manner, within

operating specifications, and under normal conditions.
• Microchip values and aggressively protects its intellectual property rights. Attempts to breach the

code protection features of Microchip product is strictly prohibited and may violate the Digital
Millennium Copyright Act.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its
code. Code protection does not mean that we are guaranteeing the product is “unbreakable”.
Code protection is constantly evolving. Microchip is committed to continuously improving the
code protection features of our products.

Legal Notice
This publication and the information herein may be used only with Microchip products, including
to design, test, and integrate Microchip products with your application. Use of this information
in any other manner violates these terms. Information regarding device applications is provided
only for your convenience and may be superseded by updates. It is your responsibility to ensure

https://www.microchip.com/
https://www.microchip.com/pcn
https://www.microchip.com/support
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that your application meets with your specifications. Contact your local Microchip sales office for
additional support or, obtain additional support at www.microchip.com/en-us/support/design-help/
client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS". MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR
PURPOSE, OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR
ITS USE WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO
MICROCHIP FOR THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk,
and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages,
claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise,
under any Microchip intellectual property rights unless otherwise stated.

Trademarks
The Microchip name and logo, the Microchip logo, Adaptec, AVR, AVR logo, AVR Freaks, BesTime,
BitCloud, CryptoMemory, CryptoRF, dsPIC, flexPWR, HELDO, IGLOO, JukeBlox, KeeLoq, Kleer,
LANCheck, LinkMD, maXStylus, maXTouch, MediaLB, megaAVR, Microsemi, Microsemi logo, MOST,
MOST logo, MPLAB, OptoLyzer, PIC, picoPower, PICSTART, PIC32 logo, PolarFire, Prochip Designer,
QTouch, SAM-BA, SenGenuity, SpyNIC, SST, SST Logo, SuperFlash, Symmetricom, SyncServer,
Tachyon, TimeSource, tinyAVR, UNI/O, Vectron, and XMEGA are registered trademarks of Microchip
Technology Incorporated in the U.S.A. and other countries.

AgileSwitch, ClockWorks, The Embedded Control Solutions Company, EtherSynch, Flashtec, Hyper
Speed Control, HyperLight Load, Libero, motorBench, mTouch, Powermite 3, Precision Edge,
ProASIC, ProASIC Plus, ProASIC Plus logo, Quiet-Wire, SmartFusion, SyncWorld, TimeCesium,
TimeHub, TimePictra, TimeProvider, and ZL are registered trademarks of Microchip Technology
Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut,
Augmented Switching, BlueSky, BodyCom, Clockstudio, CodeGuard, CryptoAuthentication,
CryptoAutomotive, CryptoCompanion, CryptoController, dsPICDEM, dsPICDEM.net, Dynamic
Average Matching, DAM, ECAN, Espresso T1S, EtherGREEN, EyeOpen, GridTime, IdealBridge,
IGaT, In-Circuit Serial Programming, ICSP, INICnet, Intelligent Paralleling, IntelliMOS, Inter-Chip
Connectivity, JitterBlocker, Knob-on-Display, MarginLink, maxCrypto, maxView, memBrain, Mindi,
MiWi, MPASM, MPF, MPLAB Certified logo, MPLIB, MPLINK, mSiC, MultiTRAK, NetDetach, Omniscient
Code Generation, PICDEM, PICDEM.net, PICkit, PICtail, Power MOS IV, Power MOS 7, PowerSmart,
PureSilicon, QMatrix, REAL ICE, Ripple Blocker, RTAX, RTG4, SAM-ICE, Serial Quad I/O, simpleMAP,
SimpliPHY, SmartBuffer, SmartHLS, SMART-I.S., storClad, SQI, SuperSwitcher, SuperSwitcher II,
Switchtec, SynchroPHY, Total Endurance, Trusted Time, TSHARC, Turing, USBCheck, VariSense,
VectorBlox, VeriPHY, ViewSpan, WiperLock, XpressConnect, and ZENA are trademarks of Microchip
Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

The Adaptec logo, Frequency on Demand, Silicon Storage Technology, and Symmcom are registered
trademarks of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary
of Microchip Technology Inc., in other countries.

https://www.microchip.com/en-us/support/design-help/client-support-services
https://www.microchip.com/en-us/support/design-help/client-support-services
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Germany - Rosenheim

Tel: 49-8031-354-560

Israel - Ra’anana

Tel: 972-9-744-7705

Italy - Milan

Tel: 39-0331-742611

Fax: 39-0331-466781

Italy - Padova

Tel: 39-049-7625286

Netherlands - Drunen

Tel: 31-416-690399

Fax: 31-416-690340

Norway - Trondheim

Tel: 47-72884388

Poland - Warsaw

Tel: 48-22-3325737

Romania - Bucharest

Tel: 40-21-407-87-50

Spain - Madrid

Tel: 34-91-708-08-90

Fax: 34-91-708-08-91

Sweden - Gothenberg

Tel: 46-31-704-60-40

Sweden - Stockholm

Tel: 46-8-5090-4654

UK - Wokingham

Tel: 44-118-921-5800

Fax: 44-118-921-5820

https://www.microchip.com/support
https://www.microchip.com
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